
 
 
 
 
 NEW USER’S TUTORIAL 
 

Welcome to ICAP/4, Intusoft’s suite of analog and mixed-signal simulation products. There is also a 
“New User’s Tutorial 2” as follow-on to this tutorial for non-ICAP/4Rx products. 
 
Let’s get started and test drive ICAP/4. This short guide will enable you to view an existing circuit 
drawing, enter a new drawing, set up a design simulation, view signal waveforms, modify your design 
until satisfied with its operation, and configure the windows environment to modify and save the way 
application windows come to view each design session.  See if you agree that ICAP/4 is today’s best 
and most powerful analog and mixed-signal offering.  Intusoft guarantees this by providing a 30-day 
money back policy on all of its software, except for ICAP/4 Consumer. 
 

1) Notes: The word “click” or “double click” implies pressing the left mouse button accordingly, 
unless stated as the right button. If you ever lose sight of the schematic, simulation, or 
waveform-display windows simply click the mouse on their corresponding "icon" boxes at 
the bottom of your desktop to bring them to view. The boxes are labeled "SpiceNet" for the 
schematic; "IsSpice4" for simulation windows that include real-time progressing simulation 
waveforms, plus output and error files; and "IntuScope," a full waveform-viewing and 
signal-processing tool. Resizing these windows so they come to view at a desired size 
each time is also covered.  In the unlikely event that any of ICAP/4’s programs go awry, 
click on the “ICAPS” icon at the bottom of the desktop toolbar and select “Exit Icaps.”   

 
2) Select the “Start” box at the bottom left corner of your computer’s desktop.  Select 

“Programs,” “ICAP_4,” and “Start ICAPS.”  This brings to view the ICAP/4 schematic and 
simulation environment, all in an integrated window whose banner is labeled, “SpiceNet.”   
Next, select from the “File” pulldown, “Open.”  Browse to 
C:\spice8\Circuits\PowerDemo\FlybkTemplate” and double-click on the 
FlybackTemplateDemo.DWG file. This brings the drawing to view.  Next, go the middle of 
SpiceNet’s top toolbar and you will see a small white window.  Pull down from its arrow and 
select “avg.”  This illustrates the top level of a Flyback SMPS power supply design. The 
schematic is comprised of several circuit layers, or sections, all visible in this drawing – 
more about layers in a minute. You can scroll around the design by using the window’s 
scroll bars, or by holding down the left mouse button on a blank area of the drawing and 
dragging the mouse in a desired direction. You can zoom in or out by first clicking on an 
area of interest on the drawing, then pressing the <F7> or <F8> keys. You can also left 
click the zoom icon on the right toolbar (magnifying glass), then hold down the left mouse 
button and drag around an area you want zoom into on the schematic, then release the 
mouse button. The <F6> key will fit the drawing within the schematic window.  Finally, 
holding the <Ctrl> key while moving your mouse roller up or down will zoom in or out, and 
holding the <shift> key while moving the roller will scroll the window horizontally. 

 
Note: You can have multiple schematic designs open at once but only the currently 
selected schematic will become the active project for simulation. You can tile multiple 
designs by using the “Tile Horizontal” or “Tile Vertical” commands accessed from the 
“Window” menu. You can also split a window to view multiple parts of the schematic 
simultaneously by selecting “Split” from the “Window” menu. Try moving the mouse to 
adjust the quad planes, then left click. Left mouse hold and drag in any of the planes and 
see how that portion of the schematic is independent of the others in view.  Double click the 
exact center of the cross plane lines to revert to normal view. 

 
3) Hold down the left mouse button for a moment inside the op-amp located in the lower left 

area of the design.  A gray shadow box appears around the op-amp box. Briefly hold the 
left mouse button down on the “eye-looking” icon in the left corner of the bottom toolbar. 
The corresponding layer of the design highlights in pink and its name (Subckts) is indicated 



to the left of the eye. Using SpiceNet’s powerful layering system (Options pulldown, then 
layers), a designer can assign a particular schematic layer, such as the one you 
highlighted, then add on and wire (connect) other circuit portions as new layers. 
Configurations (Options pulldown, “Configurations,” “Edit”), save designs as different 
revisions and enable instant reuse or modification to the circuitry.  

   
4) Next let’s observe a sub drawing under a high-level component from the Avg design 

hierarchy.  Right-click inside the “FLYBACK_ID” component toward the top of the design, 
then select “Push into subdrawing.”  The detailed design that resides under this component is 
now illustrated.  Right-click and choose “Return to Parent Drawing.” The creation of a 
subdrawing is covered in the IsSpice4 Manual accessed under Help pulldown, “PDF 
Manuals.” Press the <Ctrl F> keys and type “subdrawing;” around page 418 will be 
instructions. 

 
5) Let’s pull down another circuit within the design hierarchy from the small white configuration 

window used previously.  Select, “AvgSubckt.”  Copy a component from within this design 
and connect the new part back in with wires. For example, select a resistor by holding 
down the left mouse button over it until it is highlighted.  Release the mouse. Press the 
<Ctrl C> keys to copy the resistor. Left click the mouse on the schematic where you desire 
the component to be placed, then press the <Ctrl V> keys to paste it. As an alternative, you 
can hold the left mouse button down and drag a boundary box around the resistor, or any 
group of circuitry, and copy/paste using the previous steps.  In this process, you may have 
unintentionally encompassed wires alongside the moved part(s).  This is no problem 
because you can use them in connecting the parts into the schematic. Or, you can select a 
wire with the mouse, or area-select several, and press the <backspace> or <del> key to rid 
them.  Also, the <Ctrl Z> keys undo any steps you’ve taken, step by step. Under the Edit 
menu lies “Rotate,” “Flip,” and other operatives. Try these on any part in the design. Note that 
many operations have a keystroke associated with them next to their name (i.e., rotate is the 
<+> key, resistor is the <r> key, etc.). A list of all “hotkeys” lies under the “Help” menu 
pulldown. Finally, click on the second icon from the top of the far right toolbar.  This brings 
up a wiring cursor.  Simply hold down the left mouse button and drag the wire pencil from 
the desired beginning point (i.e., component leg) to an end destination such as another 
component or wire in the existing circuit. You may have to release the mouse at right 
angles, then continue wiring to the final spot. To exit the wiring mode, select the top icon on 
the right toolbar or simply press the <Esc> key. 

 
6) If you double click on any component, its parametric information is revealed in a “Component 

Properties” dialog box. The selections within this box enable you to assign or change 
component values and parameters. Double click the resistor you placed (or any resistor) and 
observe the second entry in its Properties dialog box.  There lies its current value.  It should 
be highlighted, so to change it, just type in a new value.  Try changing other values that are 
permissible.  To exit, press the “OK” button to save changes, or the “Cancel” button to ignore 
them. 

 
Bring to view the “TranSubckt” design configuration. Double click on voltage source (V2) 
toward the left of the schematic. Double-click on “Pulse” next to “TRAN Generators” toward 
the middle of the Component Properties dialog box. Observe its specifications, then select 
some of the tabs on top to see different input waveforms for construction. From the “PWL” tab 
you can simply left click anywhere in the graph as one way to create an arbitrary waveform 
stimulus. Close all dialog boxes by pressing their “Cancel” button.  Note that 30 types of 
signal generators are available from the “!Generators” Part-Type field inside SpiceNet’s parts 
browser (just press the <x> key to bring it to view). Finally, right click on a component and 
note with many of the menu items listed, if selected, a "help" button is furnished inside their 
dialog box. Along these lines, left click on the context-sensitive help icon (black question 
mark) on SpiceNet’s top toolbar. Then, select any of the menu items from SpiceNet’s 
toolbars, and left-click on a desired function. Help for that selection will come to view for most 
items. Note selecting an entity directly on the schematic with the black question mark will 
invoke general SpiceNet help. 



 
7) Let’s place a new component onto the design. Select the "Parts" pulldown from the top 

menus. "Passive" and "Active" are chosen for generic parts, which contain no specific part 
number information. Notice that resistors and capacitors (common electronic components) lie 
in the "passive" menu. Real parts with a part number, or specialized components, are chosen 
from SpiceNet’s "Parts Browser," which is positioned as the initial selection from this "Parts" 
pulldown. Select this and a dialog box will come to view showing all the types of part 
categories. Left-click any of the "Part Types" and observe corresponding selections in the 
"Sub Type" window. Then, specify any component from the "Part List" window. Finally, select 
the "Place" button. Alternatively, you can use the "Parts Browser" icon on the top toolbar, 
which looks like an open book, or simply push the <x> key on the keyboard. Re-invoke the 
parts browser and observe the "Find" box inside the dialog box. Left click on it and note that 
you can type in an actual part number (i.e., 2n2222), or a portion of a part number, and the 
browser will find all such component instances. 

 
8) Close the SpiceNet schematic window (not the outer SpiceNet shell window) by pressing 

the “close” icon in its top right banner.  Remember, you have placed new components, 
perhaps with dangling wires, so select “No” when queried to save changes.  Reopen the 
FlybackTemplateDemo.DWG file.  Select the “AvgSubckt” configuration as you did in Step 
5.  To its right lies another small white window.  Pull down the “tranAvg 1m” as a simulation 
setup configuration.  

 
To observe how a simulation is setup, under the “Actions” pulldown menu from the “SpiceNet” 
window, select “Simulation Setup” then “Edit.” As an alternative, you could have selected the 
simulation-setup icon in the upper toolbar (shaped like a pencil on top of a waveform).  Inside 
the dialog box, the “Transient” box is checked, so click on it if you want to observe its 
simulation setup information.  Click on other analysis boxes to see how they’re set up, or 
would be set up. “Analysis” and “Convergence” wizards are selectable near the top of the 
dialog box.  The “Analysis Wizard” is designed to help a user in setting up a simulation.  The 
“Convergence Wizard” is used to guide a user automatically if changing SPICE convergence 
parameters becomes necessary on very complex design.  You can select these and become 
familiar with them. When finished, press “Done” to close the main dialog box.  Press the "Run 
Simulation" icon from the top toolbar, which looks like a person running. An "IsSpice4" 
window comes to view. A blue window inside the IsSpice4 shell provides a thumbnail sketch 
of real-time progressing waveforms as the simulation runs.  Pressing the <Ctrl T> keys 
resizes these waveforms. Other windows provide a simulation output file and any error 
information. Note that a dialog box comes to view titled, "After Simulation Go To” (also 
accessed from the “Options” pulldown. This enables either the schematic, IsSpice4 
(simulator), or IntuScope window to be active (visible) following design simulations. Select the 
SpiceNet choice and have the "show this dialog after each simulation" box unchecked. You 
can always change your selection by recalling this dialog box from the IsSpice4 window’s 
"Options" pulldown menu. Press OK.  Now left click on the IsSpice4 window’s banner.  If a 
"Simulation Control" window appears, click on the "minimize" button.  To have these windows 
appear in the future as they are positioned now, or any way you reposition them, select from 
the “Options” menu pulldown, “Save Preferences.” 

 
9) Let’s insert a test point at a desired node by clicking on any part of a wire or connection 

point (red dot and number). Select the “Parts” pulldown at the top of the window.  Choose 
“Test Point” and “Voltage.” This will insert the test point where your insertion box is.  Select 
the “Options” pulldown and “Rubberbanding.”  Carefully hold down the left mouse button 
exactly on the test point symbol (horizontal “Y”) and drag it a short distance away from its 
present location. Wire connectivity will be maintained. Try other components. Note: You 
can hold down the <alt> key to temporary toggle the rubberbanding state on/off. Also, the 
four icons to the right of the "Scope" icon turn on or off, and refresh the design’s DC operating 
point display on the schematic. If you don’t see the information appear after selecting the “V” 
or “AW” icons, click on the “Refresh” icon. Click on the drawing and the display will assume 
colors. Note: Refresh only works if the IsSpice4 window is still available 

 



10) There are several powerful debug features available from the “IsSpice4” window, such as 
schematic-less sweeping of components.  Those are covered in the Getting Started manual, 
plus as an exercise in the New User’s Tutorial 2.  Let’s now view waveforms using ICAP/4’s 
powerful waveform viewer and signal processor called, “IntuScope.”  Note that simulation 
functions, such as “simulation setup,” “IntuScope,” etc. are selectable by icon or from the 
“Action” pulldown menu of the “IsSpice4,” “SpiceNet” and “IntuScope” windows. The "Scope" 
(IntuScope) icon looks like the crosshairs as found on an oscilloscope, and is located on the 
top toolbar of SpiceNet..  Next, click on the Scope icon. IntuScope’s "Add Waveform" window 
comes to view. Inside, click on any of the design node names or components shown in 
IntuScope’s "Y-Axis" window. Each time you select a node or component, click the "Add" box 
at the lower left corner of this dialog box. If you desire the schematic window, IsSpice4 
windows, and/or IntuScope windows to be viewed simultaneously, this will be addressed in 
Step 12 below.   

 
11) Cross probing is simple and enables you to view waveforms directly from the schematic into 

IntuScope, or display them right on the drawing. Optionally, first delete any waveforms you 
may have added in IntuScope’s viewing window by clicking on any of their names atop and 
pressing the <backspace> or <delete> key on your keyboard. Select the "SpiceNet" box at 
the bottom of your screen to bring the schematic to view. At the toolbar on the far right of the 
schematic page, select the icon that’s fifth from the top, called "Probe." When you want to 
deselect Probe, select this toolbar’s top icon, or press the <Esc> key, or right click the mouse. 
If you left-click the Probe cursor on any circuit wire or device, a corresponding waveform will 
automatically appear in IntuScope. Try a few.  If you cross-probe while holding down the 
<shift> key the waveform will appear directly on the schematic. The thumbnail waveform can 
be resized by left-mouse holding one of the small black lines on the perimeter box and 
dragging to a desired size. Probe a few entities in the design without holding the <shift> key 
and bring IntuScope to view. If the waveform data is too packed to read clearly, select the 
zoom icon (magnifying glass) in the IntuScope window. Hold down the left mouse button and 
drag a rectangle around the desired waveform section. Repeat if necessary. A powerful 
zooming tool is found under the “Scaling” menu pulldown, then “Scaling Dialog.” Here, left 
hold the mouse down and drag any of the borders to zoom in on the thumbnail drawing.  
Press “Apply” to see the display in the main IntuScope view.  “Auto Scale” restores the 
original IntuScope display. Next, find the “Link All Y” and “Unlink All Y” IntuScope icons on its 
top toolbar (hold the mouse cursor over them to see their name) and see what effect they 
have on the display.  Try other icons. 
 
There are numerous functions provided in IntuScope’s waveform calculator, all useful for instant 
signal processing. View the many selections from the "Calculator" pulldown menu. Click on a 
waveform name at the top of the graph. Try some of the functions from the calculator menu and 
see the results instantly display.  If you hold down the left mouse button and drag the cursors 
(labeled “0” and “1”) horizontally across the waveforms, note the numerical information change 
toward the bottom of IntuScope. Finally, in the Add Waveform dialog box, you can select 
different types of simulation runs for waveform display from the “Type” box, if more than one 
analysis type was performed. 
 

12) Note that you may have had a preference on how various windows come to view each time 
during the above tasks.  Advantageously, there’s a valuable way of customizing this, 
especially useful during repetitive simulation runs and waveform viewing.   

 
First, maximize the inner schematic window.  Then, resize the outer shell window by 
holding down the left mouse button while selecting the outer corner of the SpiceNet 
window. Drag the mouse to shrink the window to about two-thirds the screen size. Next, 
press the "fit to page" icon in the upper schematic toolbar (shape of a blank computer 
screen), or, simply press the <F6> key. This resizes the schematic to fit the window. Now, 
resize the IntuScope window in the same fashion. Next, hold down the left mouse button on 
the SpiceNet window’s top banner, and move the window to exactly where you want it on 
the screen.  Repeat this for the IntuScope window. In both windows, select the "Options" 
pulldown and select "Save Preferences." Finally, bring the IsSpice4 window to view by 
selecting its box at the very bottom of the desktop. There are three to four separate 



windows here. First, shrink the size of the blue “simulation status” window so only the 
"Analysis Complete" message shows toward the top. Then, move this window toward the 
bottom of the main IsSpice4 window. Minimize the "Simulation Control" window (if it 
appears) by selecting the "minimize" icon in its banner. Reduce the "Errors and Status" 
window to a small size that’s still readable. Reduce the "Output" window to roughly the 
same size as the "Errors and Status window." Finally, shrink the main IsSpice4 window to 
encompass all the other windows you modified. The figure below shows an example of this 
window environment. Try any re-sizing scheme you want.  
 

 
 

  One possible window configuration preferences for debug cycles 
 

From the "Options" pulldown menu in the IsSpice4 window, select "Save Preferences." 
From this point on, the schematic, IsSpice4, and IntuScope windows will all come to view in 
this fashion. You can resave preferences at any time to change the way these windows 
come to view in the future. 
 
A use for this "save preference" example would be for debugging a design. Example: Double 
click on a component to change its value or parametric data, re-simulate the design by selecting 
the simulation icon, then cross-probe a design node or component to bring waveforms to view 
in IntuScope. During this procedure, all windows will come to view as prescribed when you 
"saved preferences." Along these lines, in the IntuScope window, select the "Actions" pulldown 
and choose the "Update" menu. Select any of the last three functions. These enable new 
waveform data of previously viewed signals in your waveform plot to be automatically updated 
after a simulation run, simply by pressing the <Ctrl U> keys after a run is complete. Depending 
on which option you selected, previous waveform data will be overwritten with the new data, or 
appended to the same waveform plot, or inserted into a new plot. 
 

13) Select the “AvgSubckt” configuration in the SpiceNet window.  To its right, select the 
“tranAvg 1m” simulation setup. To automate the change of a component’s value or 
temperature (or design temperature) through a desired range, the "Alter" function located in 
the schematic’s right-hand toolbar can be used. Select the "Alter" icon. Note that once a 
simulation is initially run on the design, only then is the "Alter" function enabled. Place the 



magnifying-glass cursor that appears over C11 (find C11 by pressing <Ctrl F> keys), and 
left-click the mouse.  In the “Alter” dialog box, select the “Linear” circle toward the top.  Hold 
down the left mouse button and highlight the existing value in the “Start” box.  Press the 
<backspace> key to delete it.  Type in “1u.”  Repeat these steps for the “Stop” box to the 
right and type “20u.”  Type in “5u” in the “Step” box.  Next, left-click “vout” in the “Y Axis” 
box toward the left of the dialog box.  To its right, left-click the “Add to Plot List” box.  
Finally, click on the “Run” box at the bottom.  A curve family is automatically produced in 
IntuScope for the four simulation runs representative of the sweep (this will take up to a 
couple of minutes).  Use IntuScope’s Zoom function to see detailed waveform variations for 
the curve family of V_2.  Quickly try selecting any “link,” “tile,” and “cascade” icons in the 
IntuScope toolbar to see what effect they have in displaying the waveforms. Incidentally, 
ICAP/4 provides two other powerful methods of sweeping, one that produces marching 
waveforms while simply pressing a button to vary a component. These methods are 
covered in the next tutorial. 

 
14) Congratulations!  You have now acquired enough basic skill to perform design and debug 

tasks using ICAP/4.  If you are using demo software, the power and feature set of ICAP/4 
extends far beyond demo version capability.  For now, you can view a wealth of functions 
from the pulldown menus provided at the top of the schematic, simulation and IntuScope 
windows.  To get your feet wet, left-click on the black question mark icon from SpiceNet’s 
toolbar. Then, left click on the “simulation control” icon (light blue square). Review the help 
information that comes to view. The simulation-control dialog box will be a valuable feature 
as you progress into more advanced design-verification analysis.  Your next step in 
learning more about using ICAP/4 to a fuller potential is to go through the “New User’s 
Tutorial 2,” and/or the full “Getting Started Guide.” Both of these documents are accessed 
from SpiceNet’s help pulldown. There are also movies on the design flow process by 
selecting "Tutorial Movies." 

 
15) Please provide your feedback on this tutorial by emailing Intusoft at: rmktg@intusoft.com
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